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Prolog Converge View and Redline

The Prolog Converge Document Viewer is an additional document viewer tool that you can purchase and use
to review and provide feedback on technical drawings.
The Prolog Converge Document Viewer enables you to access many document viewing and annotation func-
tions including:

l Viewing a document

l Printing a document

l Zooming the document to view it

l Panning across wide documents

l Rotating the document or image

l Adding Markups to the document

l Toggling Vector layer support (switching layers on and off)

l Clipping areas from the screen to metafiles and bitmaps (clipboard support)

l Adding hyperlinks to the document

l Viewing file information

Document Viewer Window
The Prolog Converge Document Viewer window includes a work area, a menu and toolbars above the work
area, and a status bar across the bottom.
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Accessing the Document Viewer for the First Time
The first time you access the Prolog Converge Document Viewer, you will be prompted to download a web
viewer component and install it on your local machine.

Ensure that your browser's security setting allows downloading and running ActiveX controls. Also, you must
have administrator rights to install software on your computer.

Note: Rasterex is an ActiveX control that is only supported in Internet Explorer. Because Prolog Viewer uses
Rasterex to display your files, Prolog Viewer is not supported in Firefox and Chrome.

Using the Converge Viewer
Using the document viewer tool, you can view files that have been uploaded from the following locations:

l Local drives

l Network drives

l Intranet addresses

l Internet addresses.
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For more information on how to upload files, see View Files to Redline.

Multiple files can be loaded and viewed simultaneously, and viewing is enhanced with functions including fast
zoom, pan, and paging support.

The Prolog Converge Document Viewer enables annotating of file contents by adding graphics and text into
markup layers. Markups are stored in separate files. Multiple markup layers are supported.

View Files to Redline
To view and annotate technical drawings, ensure that you have the document viewer tool installed on your
computer. You cannot view or add redlines with the default Windows viewer.

To view a project file in the Prolog Converge Document Viewer:

1. Open a project in Prolog Converge.

2. On the View menu, click Project Files > View Files.

3. Double-click the folder to display a list of existing project files - or- click Upload New to add a file to
this folder.

4. Select a file and then click View. The View Document dialog is displayed.

5. Click Prolog Converge to launch the Prolog Converge Document Viewer.

Set Viewer Options
You can define the settings for the Prolog Converge Document Viewer tool using the Options dialog. You can
specify the display operations settings , printer settings, 3D options and the application settings.

To set the viewer options

1. Locate the file for which you want to set viewer options and open it using the Prolog Converge Docu-
ment Viewer.

2. Select Options from the Tools menu or right-click the document. The Options dialog is displayed with
the General Tab selected by default. The list of options under each area is expanded by default.

3. Use the following options to specify the viewer settings on the General Tab:

Option Description

Display Operations

Fill drawing polygons Displays vector polygons filled. Do not use this option if you require a
faster display.

Enable Fast Draw Reduces use of off screen bitmap refresh when markup is not used to
speed up image refresh.

Enable Line Weights Enables the display of AutoCAD line weights (applies to AutoCAD files).



Prolog Converge View and Redline

Page 4

Option Description

Scale Line Weights Scales the line weights to the current zoom factor. This setting can be
used if “Enable Line Weights” is selected.

Use Vector Anti-Aliasing Enables anti-aliasing of the raster that will be generated. This minimizes
the distortion known as aliasing that is created when representing a
high-resolution image at a lower resolution.

Load Default View Ensures that the zoom factor and image section are displayed for
formats with default zoom factors and image section stored in the file.

Custom Background Color Allows you to select the custom background color. When switching back-
ground color you cycle through white, gray, black and a custom back-
ground color.

Raster Display Options Allows you to set the Raster display options to display an image per-
fectly:

The following Scaled Raster Operations are available:

l Normal – Raster scaling is the fastest method of displaying during
zooming. Some black areas may disappear during zooming.

l Scale to gray – Scaling is the slowest method of displaying during
zooming, but it gives the best display results. If you have problems
reading, for example TIF files, use this option to improve clarity.

l Preserve black – Scaling is the next fastest display method. Some
black areas may disappear during zooming.

Use Halftoning for color
images

Enables display of color images where the pixels are calculated based on
the scaling and the actual pixels to provide a clear display of a color
image.

Spreadsheet Options

Display spreadsheet Grid Displays and prints the grid lines in a spreadsheet.

Multipage Documents

Mouse wheel zoom out/ in Enables zooming in or out of the document by scrolling the mouse
wheel.

Measurement / Calibrate Options

Enable Ortho Locks the measure line to 45 degree increments.

Display measurement dia-
log box

Displays the measurement result dialog after the measurement is com-
plete.

Invert drawing scale Switches numerator and denominator of the scale selected from the
Status bar. So that the scale can be given as written in a title block.

Snap Options Enables the snap function that pulls the cursor to defined points (nodes)
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Option Description

on the nearest line when performing measurements. The defined nodes
are Nearest, End point, Middle point, and Center, and each type of node
has a particular cursor shape to indicate the node type.

You can set the following snap options:

l Enable Snap – Select this to enable snap.

l Snap Marker color – Select the color to use on the snap marker.

l Snap type – Select the snap type from the following:

l Nearest – Snaps to the nearest line.

l End point – Snaps to the nearest end-point on the nearest
line.

l Middle point – Snaps to the mid-point of the nearest line.

l Center – Snaps to the center of the circle.

l Snap tolerance – Sets how far from the mouse cursor the
snap points should be detected.

Printer Settings

Enable transparent raster
images when printing

Enables documents containing transparent raster images to be correctly
reproduced on paper. This may be required for some printer drivers.

Print Hybrid Files as Raster Enables printing of hybrid files in Raster format.

3D Options

Gradient Background fill Enables the background color to be a gradient when viewing 3D files.

Application Settings

Delete uploaded files Deletes uploaded files once they are converted to content format.

Single document mode Allows only one document to be open at any one time.

External Reference Files

Upload external ref-
erenced files

Allows the Prolog Converge Document Viewer to attempt to retrieve ref-
erence files from your machine.

Markup Folder Sets the path where the Prolog Converge Document Viewer will look for
external reference files.

Always store markup on
Exit

Saves markup files on exit without giving a warning asking the user to
save changes.

Use Local Copy Copies the original file to a temporary folder and loads the file from there
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Option Description

to prevent file from being locked.

Remember Server Settings Stores current Server connection settings to registry.

4. Use the following options to specify the viewer settings on the format specific options tab of the
Options dialog:

Option Description

Display

Keep Drawing Colors Displays vector files, e.g. DWG, DGN, in the original drawing color.

Mono Drawing Displays vector files, e.g. DWG, DGN, in monochrome rather than color.

Background Color Sets the default background color to be used for files supported by the
selected filter.

Initial Rotation If a large percentage of the files supported by this filter need to be
rotated before opening (for example they may have been scanned at a
different angle), you can preset a rotation angle here.

Measure

Unit Sets the type of units required for files associated with this filter. Choose
between System, Imperial, Metric and User.

Precision Must be input for the selected units. The decimals are shown in the X
and Y coordinate fields located in the right end of the status bar when a
drawing is loaded.

Custom Unit Name Sets a name for the custom unit of measurement used if any.

One mm equals Some files have a resolution in dots per inch included in the file. Depend-
ing on the type of units selected, the resolution will be shown in dots per
inch, dots per mm or the user-defined unit selected for the filter.
AutoCAD files do not have absolute units of measurement, so for these
files you must decide the length a unit is to have. The easiest way to do
this is to use the Calibrate feature.

When available, use UPI
from file

Uses UPI (Units per Inch) information in measurements when this check
box is selected.

5. Click OK to save changes to the settings or click Cancel.

Menu Items
The Prolog Converge Document Viewer menus allow you to access and perform various view and redline func-
tions.
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File Menu

Use the File menu items to open, close and print files.

Menu Item Description

Print Opens the Print dialog box with multiple options

Save As Saves the currently open file to the local machine in the selected format.

Overlay Create an overlay composite to compare two or more images.

Recent Files Allows you to open recent files in the project.

Edit Menu

Use the Edit menu to search for and extract text.

Menu Item Description

Find Displays the Find dialog that is used to search for text in a document or drawing.

Find Next Search for the next occurrence of the search expression specified using the Find function

Copy to Clip-
board

Allow you to select a region in the open drawing that will be copied to the clipboard.

l Metafile Format

l Bitmap Format

l Copy Whole Drawing (Metafile Format)

Extract Text Opens the Extract Text dialog. For more details see Extract Text.

View Menu

Use the View menu to zoom, pan, rotate, flip and change the page in multi-page documents. Other functions
on the View menu include Measurement, Calibration and file information.

Menu Item Description

Toolbars Allows you to turn on and off the following RxViewX toolbars:

l Markup List Bar

l Layer List Bar

l Block List Bar

l Page List Bar

l Layout Bar

Zoom Allows you to select from the following zoom functions:

l Zoom Window
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Menu Item Description

l Zoom All

l Zoom 1: 1

l Zoom In

l Zoom Out

l Zoom Width

l Zoom Height

Flip Creates a mirror image of the active file. You can flip the image around the x and y axis.

Multipage Allows you to shift multipage documents one page down or one page up.

Rotate Rotates the image anticlockwise through steps of 90° each time this menu item is selected.

Calibrate Activates the calibration function.

Measure Allows measurement on the file. This function measures the length of a line, the angle
between two lines, or the area enclosed by multiple lines, inside the viewed file.

File Inform-
ation

Opens the File Information dialog.

Magnifying
Window

Activates the magnifying window that will magnify the portion of the drawing under the
cursor.

Birdseye Opens the Birdseye window that will allow you to see an overview of the drawing when
zoomed into a detail in the main window

Markup Menu

Menu items on the markup menu are only available if you are running with a ViewServer Pro license.

Menu Item Description

No Markups Toggles the visibility of all comments on/off.

Preferences Opens the Markup Preferences dialog.

Print Report Opens the Markup Print Report dialog

Layers Opens the Markup layers dialog.

Users Opens the Markup users dialog

Consolidate Functions for consolidating markup.

l Users and Layers

l Pick Entities

l Pick Options
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Menu Item Description

Export Save markup to another supported export format.

Import Imports a file.

Save Saves markup to file.

Undo Allows you to undo the last markup draw or edit action.

Push Sets the mouse cursor in push mode to activate markup links and markup notes.

Copy Copies currently selected markup.

Paste Pastes copied markup as a new markup entity.

Tools Menu

Use Tools menu to define settings for the Prolog Converge Document Viewer and individual file formats:

Menu Item Description

Options Opens the Options dialog. This dialog has two tabs for General options and format specific
options.

File Format
Filter Set-
tings

Allows you to set the file format filter settings . This is available only when running with local
RimEngine.

Pen Table Opens the Pen Table dialog.

Search Block
Attributes

Opens the dialog for AutoCAD attribute search.

Entity Inform-
ation

Allow you to show information about various elements in a drawing when you click on it
using the mouse.

Document Viewer Toolbar Reference
When you select a viewing or markup tool, the cursor changes to indicate that this tool is active. You then use
the tool by clicking at various points in the file.

The toolbars available are:

l Standard Toolbar

l Markup Toolbar

l Measure Toolbar

l Status Bar

Some tools have several options. These tools have a drop-down arrow beside them. Click the arrow to open a
list of the options.
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Standard Toolbar

The Standard toolbar buttons allow you to access and perform the following actions:

Button Description

Opens the Print dialog with multiple options.

Opens the Document Information dialog.

Zooms the image to the extent of the window. This function maintains the image’s aspect
ratio.

Zooms the image (up or down as appropriate) to its actual size. The function maintains the
image’s aspect ratio. Pan sliders will be displayed if required, to enable you to view parts of
the image that lie outside the boundaries of the window.

Zooms in towards the image so the image is enlarged. The function maintains the image’s
aspect ratio. Pan sliders will be displayed if they are required.

Zooms away from the image so the image is reduced in size. The function maintains the
image’s aspect ratio.

Fits the image to the width of the window. The function maintains the image’s aspect ratio. If
the image is too tall to fit in the window after zooming, the vertical pan slider will be displayed
to enable you to view those parts of the image that fall outside the window.

Fits the image to the height of the window. The function maintains the image’s aspect ratio.

Zooms in to a particular area of the file and fits it to the view window. Click on the top-left of
the area to be viewed and hold down the left mouse button. Drag to the selected area and
release the button.

Allows you to view parts of an image that are outside the window by grabbing the image and
moving it. The image will not move if it is less than the window size.

Rotates the image anticlockwise through steps of 90° by clicking the button. You can select
between 0°, 90°, 180° or 270° degree orientation directly from the drop down button.

When operating on a 3D model you can rotate the 3D model in all directions using the 3D
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Button Description

rotation button.

Changes the background color used for vector and monochrome raster images.

Goes to the previous page in a multipage file. The button is deactivated if the file comprises
only one page or when the first page is reached. In a spreadsheet file this lists the different
sheets. In a vector file this lists the views in the file.

Goes to the next page in a multipage file. . The button is deactivated if the file comprises only
one page or when the last page is reached. In a spreadsheet file this lists the different sheets.
In a vector file this lists the views in the file.

Activates the magnifying window that will magnify the portion of the drawing under the
cursor.

Creates a bird's eye view of the file, and allows you to pan around and select areas to zoom.
The Bird’s Eye View function provides an overview of the file, and allows you to pan around
and select areas to zoom. You can perform the following actions in the Bird's Eye View:

l Overview of an image: Activate the function and a total view of the file contents
appears in the Bird's Eye View window. Change the size of the Bird’s Eye window by
dragging its borders.

l Zooming: Place the cursor inside the Bird's Eye View window and click the right mouse
button. Drag the mouse diagonally to create a frame that marks the area you want to
zoom into. Release the right mouse button and the selected area zooms to fit the file’s
view window.

l Panning: The red indicator frame inside the Bird's Eye View window is superimposed
over the part of the file currently visible in the file workspace. Place the cursor inside
the red frame, click and hold the left mouse button, and drag the cursor until the
frame encloses the information you wish to see. As you do so, the view in the work
area changes to match the area enclosed in the frame.

Markup Toolbar

Markups are drawn with the thickness of the pen width defined in the line thickness box at the end

of the Markup toolbar. Text characters and numbers are written using Windows fonts and are not affected by
the line thickness settings.

The Markup toolbar buttons allow you to access and perform the following markup actions:

Button Description

Saves the markups to a file. The markups are saved to a file with the same name as the ori-
ginal file and with the extension as specified in the Markup Preferences dialog. The file will be
saved in the directory specified in the Markup Preferences dialog.
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Button Description

Displays the Markup Preferences dialog. This dialog box has three tabs; General, File and
Advanced.

Displays the Markup Layer Control dialog.

Toggles markups display. When markups are disabled, the remaining buttons in the markup
toolbar (except the Markup Preferences button) are grayed out.

Activates the Markup Edit function which allows you to select a markup. You can then per-
form markup functions like editing, moving, rotating, deleting, zoom, cutting and copying.
The commands available for markups vary according to their properties. The cursor changes
according to available functionality.

Allows you to undo the last markup or edit made. The button has only one undo level and is
grayed out if there is no operation to undo.

Shows the next markup entity. Subsequent use of the show next markup button will cycle
through all existing markup entities.

Displays the Find Markup Entity dialog. Use this dialog to search for Markup entities by name
or markup text matching a text search criteria.

Draws markups that hide image information and other markups. These markups are invisible
but can be selected, moved and deleted like visible markups. The “Rubber” markup color
always follows the background color of the file.

Displays the Markup Text dialog. This is used to write text directly onto the active file, and is
normally used for shorter markups.

If the text appears very small, this may be because the Line width and text size option is set to
Absolute document units, i.e. relative to the size of the original drawing. Click the Markup
Preferences button and set the Line width and text size to Current display units, then rewrite
the markup.

Displays the Markup Note dialog. Longer markup texts can be stored in notes so they do not
cover the work area.

To inspect the contents of a note, select the button and click the note.

Displays the Markup Stamps dialog where you can select from a set of pre-defined stamps
that you can use in the same way as you would use a rubber stamp on a paper draw-
ing/document. You can include information such as user signature, date and time in the
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Button Description

stamp.

Allows you to draw free-hand lines, on the active image, just like you were using a pen. Move
the curser to the desired start point, click and hold the left mouse button, and move the
cursor to draw the line.

Activates the Drawing function and allows you to access drawing tools like lines, curves and
arrows from the drop-down list beside it.

Set the thickness of lines and arrows using the line width and the line style drop-down lists.
Set the markup color and click the desired origin. To stop drawing, click the right mouse but-
ton.

Draws a rectangular or rounded rectangular area.

Rectangles can be restricted to square by holding down the SHIFT key while drawing rect-
angles.

Allows you to choose the type of measurement tool, line or area, that you want to draw as a
comment on the document/drawing.

Set the thickness of the outline using the line width box and the line color.

Allows you to set the drawing color used for new markup. You can also use this button to
modify the color of existing comments.

Toggles the marker mode.

Sets the line thickness or width for drawing lines, rectangles etc. The thickness is measured in
dots.

Sets the line style for drawing lines, rectangles etc.

Measure Toolbar

The Measure toolbar buttons allow you to access and perform the following actions:

Button Description

Enables measurement on the file. This function measures the length of a line, the angle
between two lines, or the area enclosed by multiple lines, inside the viewed file.

Initiates the calibration function.
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Button Description

Allows you to select the preferred measurement unit for the active measurement sys-
tem. The selected measurement unit will affect results in the measurement dialog as well
as any measurement markup elements added. It will also affect the height and width
properties displayed in the File properties dialog.

Opens the Drawing Scale dialog. Already available drawing scales are displayed here.
Drawing scales are saved in a file called rxcalibrate.ini.

Allows you to select the drawing scale value from a list of values already defined.

Status Bar

The Status Bar across the bottom of the program window displays the following information:

Area Description

The Progress Pane Indicates the progress of an operation being performed by the system.

Cursor Position Displays the current cursor position in x-y coordinates.

Current Unit of
measurement

Displays the current units of measurement.

User Displays the markup signature and layer for any selected comment.

Layer Displays information about any vector entity selected with the Entity Information tool.

URL Displays the selected URL link path when Push is active.

Redlining
Redlining enables you to indicate points of interest in uploaded photos, diagrams and other documents by
drawing circles, arrows, lines and boxes. You can also add text to the file to comment on an aspect of the file
to which you want to draw attention.
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Redlining can combine text with graphic indicators without permanently altering the photo or diagram file
that is uploaded to Prolog Converge.

You can redline documents using the redline tools in the Prolog Converge Document Viewer. You can add red-
lines in a number of different colors, and you can always move or delete your redlines at a later time.

Prolog Converge Document Viewer viewing capabilities are distributed under a licensing agreement with:
Rasterex (International) A.S.

P.O. Box. 15 Grefsen,

0409 Oslo,

Norway

www.rasterex.com

NOTE: To preserve the history and individuality of redlines on a particular photo or diagram, users can only
change those redlines that they added and have permission to change. Other users can view but not change
your redlines.

Add Redline Shapes

The Prolog Converge Document Viewer enables you to draw the following shapes to indicate points or areas
in a document. You can choose a variety of colors for your redline shape. If you change your mind about the
placement of a redline shape, you can move or delete the shape at any time.

The Redline Shapes that are available are:

http://www.rasterex.com/
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Button Description

Drawing Tools

Open Polyline that does not connect the first and last point to make a closed polygon.

Connect the first and last point to create a closed polygon. Closed polylines can have
the following fill types:

l Outlined: Select if the polygon is to be outlined (unfilled).

l Filled: Select if the rectangle is to be filled.

l Edged: Select if the rectangle is to be opaque.

l Hatched: Select if the rectangle is to be transparent and hatched.

Select this option to draw curved lines on the active image.

Connect the first and last point to create a closed spline. Closed splines can have the fol-
lowing fill types:

l Outlined: Select if the spline is to be outlined (unfilled).

l Filled: Select if the spline is to be filled.

l Edged: Select if the spline is to be opaque.

l Hatched: Select if the spline is to be transparent and hatched.

Draws an arrow. Select the type of arrow required from the following types:

l Single: Select if the arrow is to have only one head.

l Double: Select if the arrow is to have two heads.

l Filled: Select if the arrow is to be filled.

Rectangular Tools

Draws a rectangular or rounded rectangular area. Note that rectangles can be restric-
ted to squares by holding down the SHIFT key while drawing rectangles. The shapes
can be of the following fill types:

l Outlined: Select if the rectangle is to be outlined( unfilled).

l Filled: Select if the rectangle is to be filled.

l Edged: Select if the rectangle is to be opaque.

l Hatched: Select if the rectangle is to be transparent and hatched.
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Button Description

Draws an oval or bubble. Note that ovals can be restricted to circles by holding down
the SHIFT key while drawing ovals.

The shapes can be of the following fill types:

l Outlined: Select if the shape is to be outlined (unfilled).

l Filled: Select if the shape is to be filled.

l Edged: Select if the shape is to be opaque.

l Hatched: Select if the shape is to be transparent and hatched.

Measurement
Tools

Draws dimension lines. Dimension lines are double-headed and include the length meas-
urement in the selected units. You can choose from four different head styles:

l Lines

l Circles

l Open arrows with lines

l Closed arrows with lines.

Draws a measurement area enclosed by polylines. You can select a fill style for the meas-
urement area.

l Outlined: Select if the measurement area is to be outlined (unfilled).

l Filled: Select if the measurement area is to be filled to indicate the enclosed area.

l Edged: Select if the measurement area is to be opaque.

l Hatched: Select if the measurement area is to be transparent and hatched.

Counts elements in the drawing. You can select different shapes for the counting tool
to differentiate between different elements

To add a redline shape

1. Locate the file you want to redline and open it using the Prolog Converge Document Viewer.

2. On the toolbar, click the Drawing Tools button or the Rectangular Tools button and
select the redline shape that you want to draw. The pointer changes to the redline tool.

3. On the photo or diagram, drag the redline tool until the redline shape is the size that you want.

4. On the toolbar, click the Save button.
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Add Redline Text

You can add markup text directly to the active file using the Text tool. This feature is used to add shorter
markups like a question or a comment about the document. You can move and delete redline text in the same
way that you can move and delete redline shapes. For ease of placement, you can also rotate the text.

For longer text markups, use the Note tool.

To add redline text to a document

1. Locate the file you want to redline and open it using the Prolog Converge Document Viewer.

2. On the toolbar, click theMarker Mode button and click the Text button. The pointer
changes to the Redline Cursor.

3. Set the thickness of the markup frame and arrow using the pen width defined in the Line Width

list box on the toolbar.

4. Click anywhere on the document. The Markup Text dialog box is displayed.

5. Type your redline text in the Enter Markup Text field. Make formatting changes to the Font used and
the Style of the text inserted if required.

6. Click the OK button.The redline text that you entered is displayed on the document.

7. To change the location of the redline text, click the Edit button on the toolbar and click on the red-
line text. Move the redline text to the desired position on the document.

8. On the toolbar, click the Save button.

NOTE: If you cannot see the text you have written, or it is extremely small, this may be because the Line
width and text size are in option is set to Absolute document units which is relative to the size of the
original drawing. For example, text written in a 10 pt. font on an A0 drawing will be virtually invisible.
Click theMarkup Preferences button and set the Line width and text size are in option to Current
display units, then rewrite the markup. If you wish to delete the original markup, zoom in on the area
till you can see the markup, then select and delete it in the normal fashion.

When the Line width and text size are in option is set to Current display units, the resulting markup
text size will depend on the amount of zoom applied to the document when the text is written.

Add Notes

You can add longer markup text directly to the active file using the Note tool. This feature is used to add
longer markups without covering the work area of the document.

To read the contents of a note, click the note.
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To add a note to a document

1. Locate the file you want to redline and open it using the Prolog Converge Document Viewer.

2. On the toolbar, click theMarker Mode button and click theNote button. The pointer
changes to the Note Arrow.

3. Click anywhere on the document. The Markup Note dialog box is displayed.

4. Type your note text in the Enter Text for New Note field.

5. Click the OK button. The note is displayed on the document.

6. To change the location of the note, click the Edit button on the toolbar and click on the note.
Move the note to the desired location on the document.

7. On the toolbar, click the Save button.

Edit Markups

Markups can be edited only by the owner of the markup. The current user must own the markup in order to
select and edit it.

To select and edit a markup

1. Click the Edit button on the Markup toolbar.

2. Click a markup. The owner's name is displayed in the status bar. A selection is enclosed by a black
frame with one or more small buttons or handles.

NOTE: If you are not the owner then you cannot select or edit the markup.

3. Click outside the selection to de-select.

4. Click the editing control you wish to use and edit the markup.

5. Click Save on the toolbar to save the changes.

NOTE: Changes to markups are not permanent unless the Markup file is saved. All text entered can also be
links. You can select a file that you want to use as a hyperlink by clicking on the browse button next to the
Hyperlink field. You can also type in a URL in this field directly.

Editing Controls

The editing controls available for a markup differ based on the type of markup. After you select a markup, it is
enclosed by a black frame with one or more of the following editing controls or buttons:
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Button Description

Move Move a markup by placing the cursor inside the markup selection and clicking the left mouse
button. The cursor changes from an arrow to a hand. Click and hold the left mouse button,
and drag the markup to the desired position. Click outside the line to de-select.

Control Control button on a selected line, arrow or dimension offers Drag and Scale buttons on the
markup. Place the cursor on the button. The cursor changes to a finger. Click to access the
grip buttons.

Drag Drag and scale arrow or dimension by placing the cursor on the button, holding down the
left mouse button and dragging to move or change the length of a line. Click outside the line
to de-select. Add an offset to a dimension line by holding down the left mouse button and
drag in the desired direction.

Rotate Rotate a markup by placing the cursor on the button. The cursor changes to a finger. The
markup is rotated by holding down the left mouse button and dragging the corner of the
markup. Click outside the line to de-select.

Zoom Zoom or size a markup by placing the cursor on the button. The cursor changes to a finger.
The markup is scaled by holding down the left mouse button and dragging the corner of the
markup. Click outside the line to de-select.

You can also click the right mouse button to access the following markup editing options:

Option Description

Edit Allows you to edit the selected markup. The available options may vary depending on the
type of markup object you have selected.

Copy Creates a copy of the selected markup object.

Delete Allows you to delete the selected markup.

Bring to
Front

Allows you to move a markup to the front.

Push Back Allows you to move a markup to the back.

Marker Sets the marker mode for the selected markup object.

Outlined

Solid

Edged

Hatched

Changes the fill style of the selected markup object.
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Extract Text

The Prolog Converge Document Viewer enables you to extract all the text from a drawing or document that
contains readable text.The Extract function is active only if the drawing or document contains readable text.

To extract text from a document

1. Locate the file you want to redline and open it using the Prolog Converge Document Viewer.

2. From the Edit menu, select Extract Text. The Text Extraction dialog is displayed.

3. Click Extract to extract text from the current file if any. The extracted text is displayed.

4. Click Save to save the extracted text to a text file.

5. Click Clipboard to copy the extracted text to the clipboard.

6. Click Close to close the Text Extraction dialog.

Calibrate an Image

The Calibration function enables you to measure the length of an object on the active file and define a value
for that measurement. The ratio of the measured distance to the defined distance is remembered, and there-
after any distances measured on that file will be multiplied by this scaling factor before being presented. The
measurements are displayed using the units selected in the Filter Settings > Measure tab for the particular
file type.

To calibrate a file, the units of measurement for that file must be set to a standard type, i.e. not System. If the
Calibrate button is inactive, go to the Measure tab in the Filter Settings dialog and change the unit type.

To calibrate an image

1. Click the Calibrate button to activate the Calibrate function.

2. Move the cursor to the object to be measured.

3. Activate the Snap function if required. For more details see Set Viewer Options.

4. Click one end of the object and drag the arrow-headed line to the other end of the object to be meas-
ured. The length of the connecting line is displayed dynamically in the status bar.

5. Click again to stop calibration. The Measurement Calibration dialog is displayed.

6. Enter the measurement you want to use for the selected distance in the This measured line is field.

7. Select the Set as default for all files of this type check box if you want to apply the scaling function
to all files using the same filter.

8. Click OK to save the changes or click Cancel. Subsequent measurements on this file will use the new
scale.
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NOTE: The Calibrate function switches off switches off automatically after you have completed a calibration
operation.

Measure Distances, Angles and Areas

The Measurement function enables you to measure the length of a line, the angle between two lines, or the
area enclosed by multiple lines, on the active file. The results - Distance, Angle, Area, Accumulated distance -
are displayed in the status bar and in the Measurement Statistics dialog. The Measurement Statistics dialog
results can be copied to the clipboard then pasted into another application or document.

A Snap function is available to assist with accuracy when measuring to and from particular points on a line.

To use the measure function

1. Locate the file you want to use and open it using the Prolog Converge Document Viewer.

2. Ensure that the image is calibrated before using the measurement function.

3. Zoom in to the image to achieve the appropriate accuracy and click theMeasure button on the
toolbar to activate the Measure function.
Repeat to switch off the function.

4. From the Tools menu, select Options to open the Options dialog. Under Snap Options, select Enable
Snap to turn the snap mode on. The Snap function improves accuracy when measuring vector draw-
ings. For more details on the Snap options see Set Viewer Options.

5. To measure the distance, move the cursor to one end of the object to be measured and click. Move the
cursor to the apex of the angle and click again, then end of the object and right click. An arrow forms
behind the cursor as you move it, indicating the start point and current end-point of the measurement
line.

6. To measure the angle between two lines, move the cursor to one angle to be measured and click.
Move the cursor to the other end of the object and right click. An arrow forms behind the cursor as
you move it, indicating the start point and current end-point of the measurement line.

The Measurement Statistics dialog is displayed with the following results:

Result Description

Point The points you have clicked, 1 being the start point.

Angle The angles between the lines created.

Distance The total distance between measurement points in the current meas-
urement operation given in the selected measurement unit.

Area The area generated by the current measurement operation, given in the
selected measurement unit.

Accumulated
distance

The total distance of all the measurement operations since the last time
the Clear Accumulated button was pressed.

Accumulated The total area generated by all the measurement operations since the
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Result Description

area last time the Clear Accumulated button was pressed.

7. Click Clear Accumulated to reset the accumulated totals to zero.

8. Click Copy to copy the measurements and accumulated totals to the clipboard so that you can paste
the data into another application as a list. The text can be pasted and converted to a table in a word
processor or pasted directly into a spreadsheet.

Move Redlines

You can move any redline shapes or text that you added to a file. You cannot move redline shapes or text
added by other users. If you want to change an existing redline, you must delete the existing redline and then
add a new one.

To move a redline shape or redline text

1. Using the Prolog Converge Document Viewer, view the document containing the redline that you want
to move. By default, the viewer displays the document with all available redlines.

2. On the toolbar, click the Edit button.
The cursor becomes the select tool. Square selection handles appear around each redline on the doc-
ument.

3. With the select tool, click one of the selection handles around the redline that you wish to select.
When you select a redline, the color of its selection handles changes.

TIP: You can select multiple redlines by holding down the left mouse button and dragging the select
tool across an area containing redlines. A dashed line indicates the area that you are selecting.

4. Drag the selected redline to the desired location on the document.

5. On the toolbar, click the Save button.

Delete Redlines

You can delete any redline shapes or text that you added to a file. You cannot delete redline shapes or text
added by any other users.

To delete a redline shape or redline text

1. Locate the file for which you want to delete redlines and open it using the Prolog Converge Document
Viewer. By default, the Prolog Converge Document Viewer displays the document with all of the red-
lines that users have added.
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2. On the toolbar, click the Edit button.

3. Select the redline you want to delete by clicking on it.
You can select multiple redlines by holding down the left mouse button and dragging the select tool
across an area containing redlines. A dashed line indicates the area that you are selecting.

4. Press the Delete key. The redline is deleted.

5. On the toolbar, click the Save button.

Print from Converge Viewer

You can print documents from the Prolog Converge Document Viewer.

In the Prolog Viewer, click the Print button on the toolbar to open the Print dialog.

This dialog contains four tabs: Print, Options, Watermark and Pen Table. The options available under each tab
are:

Print Tab

Option Description

Print Portion

All Pages Prints all pages, sheets or views.

Pages Prints only a page range e.g. 1, 3-5, 10.

Whole of current
Page/ Image

Prints only the current page.

Displayed Portion Prints only the visible portion of the image as displayed.

Print Scale

Scaled to fit the
paper

Reduces or expands the image to match the paper size.

Scaled from:

to:

Allows you to enter the scale factor for printing the image. For example, Scaled from
10 to 1 will reduce the image to 1/10 its original size (though this may still require sev-
eral sheets of paper – refer to the Poster option below).

Scale in preview Scales the printout as described in Print Preview options.

Print Control

Center the printout Centers the printout on the paper.

Poster Prints over multiple sheets. You can set the number of sheets in the No. horizontal
and No. vertical fields. The number of sheets used and the position of the image are
shown in the preview window. You can scale and move the image to match the selec-
ted number of sheets as described in Print Preview options.
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Option Description

Print Monochrome Produces a black and white printer output.

Rotate Rotates the image 90 degrees from the current rotation.

Printer Allows you to check, modify or change the default Windows printer. Use the Setup
option to set the paper size, source and orientation (landscape or portrait).

Print Preview Allows you to view the printout before you print. You can fit the image to the paper
both vertically and horizontally by not checking the Maintain aspect ratio.

Options Tab

Option Description

Print Control

Maintain aspect
ratio

Allows the user to choose if the height and width ratio should be maintained when
scaling the print. If this is not selected it is possible to stretch the printed image in
only the vertical or horizontal direction.

Collate Copies Prints a complete copy of the document before the first page of the next copy is prin-
ted. If you prefer to print all copies of the first page and then print all copies of sub-
sequent pages, clear the check box.

Print Margins (Inch)

Left

Right

Top

Bottom

Fills in the required paper margins in these text boxes.

Header

Enable Header Includes header text on the printed document and drawing. Enter the text to use as
header in the text box below this field.

Footer

Enable Footer Includes footer text on the printed document and drawing. Enter the text to use as
footer in the text box below this field.

Watermark Tab

Option Description

Enable Watermark Allows you to add a watermark to the printout of your file.

Watermark as

Vertical Position

Enables you to change color, font and orientation. Position the watermark above,
below or across the drawing. Set the watermark in front of or behind the drawing.
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Option Description

Color

Orientation

Pen Table Tab

Option Description

Use Pen Table Allows you to use the Pen Table function. The other options are enabled only after
this option is selected.

Pen Settings Allows you to define how you want a particular line color on the file to be printed or
plotted.

Typically, in a vector file, lines have the same on-screen thickness but different colors.
Colors can be interpreted to create printed output with different line thickness, colors
and styles.

Width Sets the desired printed width for the selected lines. –1 indicates that width isn’t
defined for that pen.

Style Sets the desired printed style for the selected lines (full, dotted, dashed etc.). –1 indic-
ates that no width has been defined for that pen.

Color Sets the desired printed color for the selected lines.

Settings

Units Allows you to select the units of measurement, metric (mm) or imperial (inches), you
wish to use when defining line widths.

Scale Allows you to set the scale of the drawing file.

Select Scaled to resize a drawing file so that the line widths follow the scale of the
drawing.

Select Unscaled to keep the line widths constant irrespective of the scale of the draw-
ing.

Change Applies the changes to the file.

Default Returns to the default settings.

Load Loads a previously saved pen table (*.RPT) file. A Load Pen Table dialog opens to
enable you to find and select the desired file.

Save Allows you to save the table as an .RPT file after you have made the desired changes
to the pen table so that you can reuse the settings. A Save Pen Table dialog opens
enabling you to name the file and place it in the appropriate folder.
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